Expanding Access to
Community Data
Program Dashboards
using Tableau Public

Lessons learned from
the Social Planning Council of Ottawa
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Objective and Benefits

« Community Data Dashboards provide an easy access to data. They can be a
valuable resource to a range of users with various data skills.

* There is a library of dashboards created by the CD team that can be seen at the

Interactive Infographics and Dashboards Portal: ‘
https.//communitydata.ca/content/interactive-infographics-and-dashboards
« All work that requires professional skills and knowledge of data and technology

is done by CD team. The data tables are already downloaded from the catalogue,

imported to Tableau, connected, analyzed, and visualized.
* Publishing the dashboards online can expand the access to this resource. More

consortium members and local communities will have the opportunity to make

good use of the data presented in Tableau.
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https://communitydata.ca/content/interactive-infographics-and-dashboards

Complying with CDP Data Sharing
Agreement

« Community Data Program management team gave a green light to move forward
on this idea with a few important notes:

* In order to comply with the CDP end user agreement, the data access is
limited to the local consortium area - in our case Ottawa & Region.

» Before publishing, to verify with CDP data team if any of the data in the
dashboard are subject to further restrictions.

 CDP team supported the project with professional and technical assistance.
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Community Recovery Dashboard

* It was Community Recovery Dashboard (CRD) that inspired us to search for
ways to expand the access to it.

« Community Recovery Dashboard connects data from a variety of sources,
including the Census and Labour Force Survey.

* It presents many views of the data at different geography levels across Canada.

* The size of CRD is accordingly large, raising the question what can we do to
share this great resource with our data community?

 We used a two steps approach:

« Limit geographical extent to Ottawa and Region (Eastern Ontario townships).

 Limit the data to a subset of the variables available - share a series of
individual thematic parts of CRD.
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Community Recovery Dashboard continued

 We choose to use Tableau Public as a sharing platform.

* The benefits of publishing only part of a CRD, a specific theme or geographic
level:

* Reduced data volume - also needed to comply with Tableau Public size limitations. ‘

* Reducing the geography extent to specific region or municipality makes it easier to
find an area of interest.

* Improved online performance of the dashboard.

« Option to focus on a content that is of current interest to the community.

* The outcome: Community Recovery Dashboard, Labour Force and Income for
Ottawa and Region, click here to see the dashboard embedded to a website.
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https://dataforpurpose.ca/dia_resource_databas/culture-and-diversity/community-recovery-dashboard-ottawa-and-region-part-2-income-and-employment/

Tableau Public - About

Tableau Public is an open platform to publicly share and explore data
visualizations online: Attos;//public.tableau.com/

 In addition to the online platform, Tableau Public offers a desktop application.

* Visualizations created online or in the desktop app are shared via the Tableau
Public cloud service - up to 10 Gb free space can be used for your
visualizations.

 Many online resources exist for learning Tableau Public: documentation,
how-to videos, sample datasets, user forums, extensive library of data
visualizations, etc.

« Main limitation: Visualizations published to Tableau Public are available for
anyone to see online.
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Tableau Public - Overview

* Once you have a Tableau Public account, you can create an online profile providing
details about your organization or research project.

* Using the online platform, you can create and publish a visualization.

* Using the Tableau Public desktop app, you can create new or open existing
workbook.

« Creating a new data visualization using Tableau public is very similar to using
Tableau professional. The resources from CD workshops on how to use Tableau can
be used for the public version.

« Changes/edits to a dashboard can be performed both in desktop app and online.

 The Tableau Public Workbook is saved online only, and not locally.

 Clicking on the Save button in your desktop app, will prompt you to save the
workbook to public.tableau.com portal.
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Tableau Public - Share your work

Dashboard sharing and viewing
options can be modified from

an image, PDF file and Power

LW K

Tableau Workbook

: . : Share: Download:
the online settings of the Viz. click e chare Various format options
. . . icking on the share icon
For.each visualization we can opens a window with for download.
decide on: options to copy a link or
) embed code.
* Show or not the Viz on your Download
profile. share ”
Select your file format.
® ShOW or nor the Sheets Of the Original View ‘ Image
dashboard. Embed Code
<div class="tableauPlaceholder' id="viz ‘ Crosstab
 Allow others to download the -
in PDF
daShboard and data' or Only as https://public.tableau.com/shared/85 ‘
‘ PowerPoint
|

point.
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Tableau Public - Limitations Summary

* Tableau Public is an open platform with a public access, not

suitable for private data. Visualizations published to Tableau Public
are available for anyone to see online.

 Tableau Public is limited in size.
 Tableau Public works with max of 15 millions rows of data.

 If a dashboard is larger, Tableau Public can not be used.

* Workbooks saved to Tableau Public can only use Data Extracts.

» Saving locally and refreshing data are limited.

« When publishing on Tableau Public server and/or embedding to a
website, dashboard design, layout & size might have to be adjusted.
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Notes on preparing a CD Dashboard for publishing ‘

» Limiting geographies to the local consortium area is necessary in order to
comply with data sharing agreement and to reduce the data volume of a
dashboard.

 The demonstrated approach of applying filters on geographies is:

« Just one of the many possible ways to limit geographical area and reduce the data
volume.

represented data.

 |f applying filters, the outcome should be verified with the original dashboard or
original data source.

|t will not apply to all dashboards - they are organized differently, based on the I

* Further reducing the size of a large dashboard can be done by:

* Sharing the thematic tabs one at a time. Sharing the different geography tabs one at
a time.
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Publishing a CDP dashboard to Tableau Public

Workflow

( )

Save to your desktop
a copy of the original
dashboard

. J

(" )

To save on tableau
public go to: File >>
‘Save to tableau
public’ (Ctr+S)

g _J

-

Open the tableau
public desktop app.
Sign in to your
account.

~

( . )
Click OK. Test the

outcome - is
everything
functioning as
before?

( )
From the File menu
select ‘Open’ (Ctr+0)

Navigate to and
select the dashboard.

. J

(" )

Select geographies
you want to keep
from the list

-

From the Data menu
select ‘Edit Data
Source Filters’

~

\_ _J
( )
Click ‘Add.." and
select the
‘Geography’ field
from the list
\_ _J




Edit Data Source Filters

Filter

Details

Add Filter

Select a field:

Search

Age groups
Average Risk Score
Csdname

Csduid

Geography
Geography (full)
NOC

NOC code
Occupation Name
Population
Prname
Pruid
Risk level

ER

General Wildcard Condition Top

() select from list @) Custom value list () Use al

Enter Text to Search or Add

Admaston/Bromley (3547043) A
Akwesasne (Part) 59 (3501007) |
Alfred and Plantagenet (3502023)

Arnprior (507)

Arnprior (3547002)

Athens (3507042)

Augusta (3507006)

Beckwith (3509024)

Bonnechere Valley (3547035)

Brockville (512)

Brockville (3507015)

Brudenell, Lyndoch and Raglan (3547020)

Canada (0)

Carleton Place (509)

Carleton Place (3509028)

Casselman (3502044)

Champlain (3502010) v

Summary

Indlude all values when empty [_] Exclude

Edit Data Source Filters

Filter Details
keeps 74 of 5,625 members

‘Edit Data
Source
Filters' -
Process

snapshots



Tableau Public - Demo

* Create and set up an online Tableau Public Profile.
* Publish a CD Dashboard: 2021 Census Population

« Save a copy of the original dashboard on your desktop.

* Open the tableau public desktop app. Log-in to your account.

 From the File menu select ‘Open’. Navigate to and select the dashboard.
 Make necessary changes:

* Limit geographies to consortium area

* Add a note to the Welcome page

« Click Save or go to: File >> ‘Save to tableau public’
* In the online platform, adjust the view, the description and the settings.
« Share the link or embed to a website.
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Examples

Shared on Tableau public server

« https.//public.tableau.com/app/profile/spco

« https;//public.tableau.com/app/profile/spco/viz/DIYinfographic-
Villageof100_16455455894980/Villageofl00Dashboard

 https.//public.tableau.com/app/profile/manitoba.collaborative.data.portal/viz/shared/58XR38KW3

Embedded to a website

e hitps.//dataforpurpose.ca/

 https;//raisingthevillage.ca/neighbourhood-comparison-dashboard/

Shared as a link on a webpage:

« http.//www.mbcdp.ca/demographic-dashboards.htm!
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https://public.tableau.com/app/profile/spco
https://public.tableau.com/app/profile/spco/viz/DIYInfographic-Villageof100_16455455894980/Villageof100Dashboard
https://public.tableau.com/app/profile/manitoba.collaborative.data.portal/viz/shared/58XR38KW3
https://dataforpurpose.ca/
https://raisingthevillage.ca/neighbourhood-comparison-dashboard/
http://www.mbcdp.ca/demographic-dashboards.html

In Summary - Tips and Notes

* To get started, chose a smaller in size dashboard or create your own data view.
* To limit the displayed geographies:
* Download a copy of the original CD dashboard.
 Have handy a list of geographies you will keep and their corresponding unique codes.
« Make sure you understand the way data within a workbook are organized.
« Many CDP dashboards are complex and figuring out how to add filters might be tricky.

« After setting up filters on data check if the dashboard is functioning as designed.

« Verify the outcome with the original dashboard or original data source.

« Consider publishing thematic parts of a larger dashboards separately.

* |If a workbook is too large, e.g., CRD, it might be easier to publish one theme at a time.
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Tableau Public Resources

« Create a Tableau Public account and download Tableau Public desktop
application: Attps.//public.tableau.com/

« Tableau Public Resources: Attps;//public.tableau.com/en-us/s/resources

 Tableau Public FAQ: Attps.//community.tableau.com/s/tableau-public-fag

« Tableau Public Technical Support:

https.//www.tableau.com/support/public? ga=2.157776186.1656119054.1649344357
-1601095953.1649098085

 Tableau Public Blog: https.//public.tableau.com/en-us/s/blog

* Learn from experts and find inspiration:
https.//public.tableau.com/app/discover/authors
https.//public.tableau.com/app/discover/viz-of-the-day
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https://public.tableau.com/
https://public.tableau.com/en-us/s/resources
https://community.tableau.com/s/tableau-public-faq
https://www.tableau.com/support/public?_ga=2.157776186.1656119054.1649344357-1601095953.1649098085
https://public.tableau.com/en-us/s/blog
https://public.tableau.com/app/discover/authors
https://public.tableau.com/app/discover/viz-of-the-day

Tableau Public Resources

Tableau Public Viz of the Day: https.//public.tableau.com/en-us/s/viz-of-the-
day/subscribe

« Using Google Sheets as an only supported live data connection:
https.//community.tableau.com/s/tableau-public-fag#subheadi9a

 Embedding Tableau Public Views:
https.//kb.tableau.com/articles/howto/embedding-tableau-public-views-in-
Iframes?lang=en-us&_ga=2.76268178.662376734.1643299279-827884500.1642175549

 Embed Code for Custom Views:
https.//help.tableau.com/current/pro/desktop/en-us/embed_code_custom_view.htm

* TechSoup Canada: https,//www.techsoup.ca/eligibility
https.//www.techsoup.ca/product-catalog
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https://public.tableau.com/en-us/s/viz-of-the-day/subscribe
https://community.tableau.com/s/tableau-public-faq#subhead19a
https://kb.tableau.com/articles/howto/embedding-tableau-public-views-in-iframes?lang=en-us&_ga=2.76268178.662376734.1643299279-827884500.1642175549
https://help.tableau.com/current/pro/desktop/en-us/embed_code_custom_view.htm
https://www.techsoup.ca/eligibility
https://www.techsoup.ca/product-catalog

Thank youl!
Questions?

Get in touch: stefkap@spcottawa.on.ca

Check out some of our current and ongoing projects
using data from Community Data Program:

v’ 202] Census Highlights for Ottawa and Region

v’ Eastern Ontario Atlas

v’ Ottawa Neighbourhood Equity

v’ Data in Action
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mailto:stefkap@spcottawa.on.ca
http://www.cims-scic.ca/civicrm/mailing/url?u=155&qid=6657
http://www.cims-scic.ca/civicrm/mailing/url?u=179&qid=6877
https://neighbourhoodequity.ca/
https://dataforpurpose.ca/

